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Premessa

Il testo sviluppato in questo documento & stato utilizzato come base per il seminario da
me tenuto all'edizione di Webb.it 04 a Padova nel giorno 8 Maggio 2004 a pochi mesi
dall'uscita di GIMP 2.0.

Molto di quanto detto qui non € una novita ma mi sono proposto tra i numerosi articoli e
discussioni da me seguite di farne un non poco corposo documento accessibile a tutti
quelli che, nel panorama italiano, sperano di poter accedere in maniera comprensibile e
immediata a questo stupendo strumento per la grafica disponibile in formato open source.
Spero con questo di poter appianare i numerosi dubbi che attanagliano i piu, e
specialmente i meno, addetti ai lavori del settore. Vi auguro quindi buona lettura e
ringrazio fin d'ora i GeCHI e tutti coloro che mi hanno aiutato e sopportato e supportato in
questi mesi.

Quello di cui si parlera in questo documento €&, spero, tutto quello che vorreste sapere su
questo stupendo programma di grafica. Schematicamente ho proceduto alla stesura del
testo seguendo lo sviluppo logico dalle prime fasi dall'installazione, la configurazione e |l
vero e proprio impiego, con tutti i dubbi e possibilita che mi sono potute venire nel corso
della esperienza personale mia e di altri utenti con GIMP.

TODO: di cosa non si parlera in questo documento.

Alcune sezioni sono risultate particolarmente ostiche nella stesura, tra tutte cito il
paragrafo riguardante il paragone tra GIMP e PhotoShop: come infatti spiegherd questo
documento non vuole convincervi che GIMP € meglio di qualsiasi altro programma; in un
certo senso cerco di mettere in evidenza pregi e difetti, valutando quanto piu
obiettivamente il reale funzionamento dello stesso o quantomeno mi pongo I'obiettivo di
offrirvi gli strumenti per fare cio che volete.
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Introduzione
GIMP nasce nel 1995 ad opera di Spencer Kimball e Peter Mattis.

GIMP & I'acronimo di GNU Image Manipulation Program (Programma di Manipolazione di
Immagini GNU), un programma open source che aderisce alla licenza GPL-2, che
permette la sua libera copia, distribuzione e modifica.

Il programma in se € uno tra i pit completi e ben organizzati all'interno del panorama open
source mondiale; pud essere usato come semplice programma di grafica (pittura), come
un programma di fotoritocco sufficientemente professionale, come un sistema di batch
processing online, come un sistema di modifica di massa di files, quindi convertitore e
quant'altro.

Fondamentali tra le sue potenzialita sono la strutturazione modulare, l'espandibilita e
I'estensibilita.

Qualsiasi processo di produzione interno, dalla piu semplice delle operazioni alla piu
complessa operazione di manipolazione di immagini, in GIMP pud essere facilmente

realizzata tramite uno script, un semplice file di testo caricato dinamicamente all'interno
dello stesso.

GIMP ¢é sviluppato principalmente sotto X11 su piattaforme Unix ed & testato sulla
maggior parte dei sistemi Unix-like come Linux e Solaris. Inoltre gira nativamente (quindi
senza bisogno di emulazioni o altro) su Windows e sotto X11 su MacOS X.



Ottenere ed installare GIMP

Gimp per Unix e fratelli

GIMP €& chiaramente distribuito essenzialmente in codice sorgente, ma sono state messe
a disposizione per le maggiori distribuzioni GNU/Linux, compreso FreeBSD, anche dei
pacchetti precompilati.

| requisiti minimi di sistema vanno da processori quali un Pentium 200 o una vecchia
workstation (come I'Ultra1). La quantita di memoria, specialmente se si vuole avere a che
fare con immagini particolarmente ingombranti, & un fattore discriminante: un minimo di
128 MB di RAM & raccomandato, ma per immagini davvero grandi almeno 256 MB e
svariati GB possono davvero essere un buon punto di partenza.

Per quanto riguarda le dipendenze, GIMP gira sotto X11 (sia esso Xfree o Xorg), quindi,
apparte le librerie grafiche di X, & necessario:

una versione recente di pkg-config reperibile da
http://www.freedesktop.org/software/pkgconfig/

Le GTK+ 2.2.2 o superiori (Gimp Tool Kit) (reperibile da: ftp://ftp.gimp.org/pub/gtk/) le
GTK+-2.2 dipendono a loro volta da versioni recenti di:

Glib
Pango

ATK che potete comunque reperire da ftp://ftp.gimp.org/

PangoFT2 una backend per Pango che usa FreeType2 (siate certi di aver installato
FreeType2 prima di installare Pango) potete trovare tutto su http://www.freetype.org/

libart2 prendete il modulo dalla libart_Igpl che trovate sul CVS di GNOME o prendete il
tarball da ftp://ftp.gnome.org/pub/gnome/sources/libart_Igpl/

Se state per compilare GIMP da sorgenti avrete bisogno degli header files per le librerie
richieste. In alcune distribuzioni di Linux questi header files sono rilasciati in pacchetti
separati con il suffisso -devel.

Gimp per Windows

Le versioni eseguibili per Windows di GIMP sono reperibili da differenti siti rispetto a
http://www.gimp.org che invece fornisce i semplici codici sorgenti:

Jernej Simoncic (http://www2.arnes.si/~sopjsimo/gimp/) fornisce un installer che vi
guidera nel processo di installazione, questo € sicuramente il metodo migliore per avere
GIMP sotto Windows.

Tor Lillgvist (http://www.gimp.org/~tml/gimp/win32/downloads.html) mette a
disposizione diversi archivi zip con il programma, librerie e diverse risorse per utenti e
sviluppatori.

Inoltre http://www.ftgimp.com e http://www.wingimp.org vendono versioni di GIMP

Sebbene GIMP 1.2 fosse certificato girare su tutte le piattaforme Windows disponibili sul
mercato, per GIMP 2.0 sarebbe opportuno usare una versione di Windows basata su NT
(NT4, 2000 o XP): come si legge nelle FAQ dal primo sito di Simoncic, Windows 98 non &
piu supportato, se si riscontrano dei problemi e volete risolverli dovrete debuggarvi da soli
il programma. La quantita di memoria € un fattore molto importante specialmente se
lavorate con immagini grandi: un minimo di 64MB di RAM & raccomandato.

http://members.home.nl/m.weisbeek/gimp/ una introduzione all'interfaccia grafica di GIMP.




GIMP per MacOS X

Oltre al codice sorgente messo a disposizione da www.gimp.org gia citato
precedentemente, ci sono svariate soluzioni per ottenere GIMP preconfezionato che
dovrebbe rendere l'installazione e la configurazione un gioco da ragazzi:

Gimp.app (http://gimp-app.sourceforge.net/) mette a disposizione un pacchetto
abbastanza compatto di GIMP per OS X. Gimp.app richiede X.app di Apple.

Fink (http://fink.sourceforge.net/pdb/package.php/gimp) & un sistema di gestione dei
pacchetti ospitato da Sourceforge.net e mette a disposizione ogni cosa necessaria per
installare GIMP. Il progetto Fink & basato sui tools di apt-get di Debian per la gestione e
I'adempimento delle dipendenze dei vari componenti necessari a GIMP per essere
installato. Una installazione tipica, comunque, necessita che voi abbiate un compilatore
C funzionante, che Apple distribuisce su un CD insieme a OS X. La directory in cui
viene installato GIMP & /sw/bin/gimp

In maniera simile, DarwinPorts (http://darwinports.opendarwin.org/) mette a
disposizione diversi prodotti open source in maniera semplice da installare. La directory
su cui viene installato GIMP in questo modo & /opt/local/bin

Nel futuro si spera che il progetto MetaPkg (http://www.metapkg.org/) possa gestire e
unificare questi diversi metodi di installazione, ma al momento il meta packaging
system € inutilizzabile.

Il progetto MacGIMP (http://www.macgimp.org/) mette a disposizione l'ultimo GIMP per
MacOS X in formato CD. Questi installano GIMP in /opt/local/bin

GIMP gira esclusivamente su MaxOS X e non sulle versioni precedenti come la 9. Quella
che segue € una breve lista di quello che vi servira per far girare GIMP sul vostro Mac.

Livello X Window: GIMP usa un livello separato per la gestione delle finestre, il
protocollo di X11, sotto MacOS X, che deve essere installato precedentemente. Il
Progetto XDarwin (http://www.xdarwin.org/) mette a disposizione questa funzionalita.
Apple ha recentemente iniziato a costruire una sua versione di questo protocollo basato
su Xfree, che verra chiamato X11.app. E' disponibile in beta version su
http://www.apple.com/macosx/x11 .

dicompact: in generale installare GIMP su Mac & complicato dal fatto che le librerie
dinamiche della GNU richiedono una libreria di caricamento dinamico specifica.
dlcompact fornisce l'interfaccia dlopen() per il caricamento dinamico. Viene rilasciata
tramite Fink e in pacchetto da OpenDarwin (http://www.opendarwin.org/cgi-
bin/cvsweb.cqi/proj/dicompat/) .

Librerie Grafiche e ToolKit: A differenza delle distribuzioni Linux, MacOS X non viene
rilasciato con le librerie grafiche Open Source grazie alle quali viene installato GIMP.
Generalmente queste vengono installate con GIMP stesso, ma & possibile installarle
separatamente. Le librerie GTK+ poi possono essere installate tramite i vari sistemi di
gestione dei pacchetti menzionati precedentemente: Fink, DarwinPorts, OSXGNU e
altri...



Configurazione di GIMP

The first-run

Una volta lanciato GIMP dopo averlo installato veniamo accolti da una schermata di
configurazione e post-installazione, nella quale, dopo la visualizzazione della licenza GPL
vengono create le cartelle per salvare i file propri di GIMP e quindi viene fatta una
configurazione di massima (accessibile e personalizzabile anche successivamente da
[ToolBox]>File>Preferenze).

Genericamente per l'utente medio che inizia anche per la prima volta ad usare GIMP
continuare a premere Continua pud essere una soluzione rapida ed indolore. Alla fine di
queste schermate di installazione ci verra presentato I'elenco dei file creati e il loro
percorso.

Riuscire invece ad ottimizzare GIMP per migliorare la performance, non € sempre facile, a
questo proposito € necessario fare una nota chiarificatrice sulla TILE-CACHE (o Cache-
Immagine), in quanto richiede alcune informazioni aggiuntive.

L'ottimizzazione: La Cache Immagine

L'elaborazione delle immagini possono richiedere notevole spazio. GIMP utilizza i servizi
del sistema operativo per gestire la memoria, fino ad un certo punto, oltre il quale usa |l
proprio sistema. Questo sistema consiste nel mandare i vecchi dati sotto forma di file sul
disco. In altre parole il limite delle risorse di sistema utilizzabili. Questo non comprende la
memoria usata da GIMP stesso, semplicemente lo spazio richiesto per le immagini
(misurato in Bytes o in MegaBytes).

Un valore troppo basso per la cache immagine fa si che GIMP mandi i dati su disco
velocemente, senza fare reale uso della RAM disponibile e facendo cosi lavorare il disco
senza reali motivazioni. Un valore troppo alto renderebbe disponibili poche risorse di
sistema alle altre applicazioni, le quali avrebbero la necessita di swappare, facendo cosi
lavorare il disco: potrebbero quindi iniziare a lavorare male o venire uccise per mancanza
di memoria RAM.

Scegliere un numero per la Cache Immagine

Ci sono vari modi per decidere quale valore usare per la Tile-Cache cosi come alcuni
trucchi:

- Dimenticare di quello che avete letto o di quanto seguira in questo paragrafo sperando
che il valore di default vada bene. Funziona quando GIMP viene usato per creare
immagini piccole tenendo aperte una o due applicazioni contemporaneamente. Se
volete qualcosa di semplice da usare, per fare Screenshots e alcuni logotipi, questa
potrebbe essere la migliore soluzione.

- Domandate a qualcuno di farlo per voi, specialmente se state lavorando su macchine
che servono piu utenti contemporaneamente, in tal modo evitereste che
I'amministratore di sistema e gli altri utenti impazziscano perché voi state abusando
della macchina, e inoltre non dovrete avere a che fare con un'installazione di GIMP non
performante. Se & la vostra macchina e ha un solo utente alla volta questo intervento
esterno potrebbe significare un corrispettivo in denaro (o drink) per il prestato
servizio. ;)

- Iniziate con il cambiare il valore di volta in volta, controllando che venga incrementata la
performance, e contemporaneamente che il sistema non si lamenti di mancanza di
memoria. Siate preavvisati che spesso la mancanza di memoria termina nell'uccisione
di alcune applicazioni per fare spazio ad altre.



- Fate alcuni semplici calcoli matematici per ottenere un valore ottimale. Probabilmente
successivamente dovrete aggiustarlo magari con uno dei metodi sopra descritti.
Quantomeno capirete cosa sta succedendo e potrete ottenere il meglio dal vostro
sistema.

Che numero usare per la Cache Immagine?

Supponiamo che voi abbiate scelto I'ultima opzione per ottenere un valore decente da cui
iniziare. Innanzitutto avete bisogno di alcune informazioni sul vostro sistema: la quantita di
RAM installata, lo spazio di swap disponibile per il sistema e un'idea generale sulla
velocita dei dischi che vengono utilizzati per lo swap di sistema e la directory di swap di
GIMP. Non avete bisogno di fare dei test sui dischi e nemmeno di sapere gli RPM, la cosa
da vedere € quale dei dischi risulta piu veloce o piu lento o se sono tutti simili. Ricordate
che la directory di swap di GIMP & possibile reimpostarla da [ToolBox]
>File>Preferenze>Cartelle>Directory di swap.

La seconda cosa di cui necessitate sapere € lo spazio impiegato dalle altre applicazioni
che intendete usare nello stesso momento. Quindi aprite tutti i vostri strumenti e lavorateci
un po' (ad eccezione di GIMP chiaramente) e controllate l'uso. Potete usare applicazioni
tipo top 0 free in base al sistema operativo che state usando e dall'ambiente di lavoro. Il
numero di cui avete bisogno &€ la memoria residua, compreso il file di cache. | moderni
sistemi UNIX mantengono una piccola area di memoria libera, per essere in grado di
gestire file di grosse dimensioni e la cache dei buffer. || programma free di Linux fa i
calcoli per voi, controllate le colonne che dicono 'free' e '-/+ buffers/cache/
annotatevi inoltre lo spazio di swap libero. Sotto Windows c'é la possibilita di usare il
monitor di sistema richiamabile con CTRL+Maiusc+ESC.

Ora & il momento delle decisioni e dei calcoli. Il concetto di base & di decidere se volete
che la Cache dell'immagine risieda solo nella RAM o anche nello swap di sistema:

1. Cambiate spesso applicazione? O continuate a lavorare con GIMP a lungo? Se state in
GIMP a lungo potete considerare la RAM libera piu lo spazio di swap libero come
disponibile, altrimenti controllate i punti successivi. Se siete insicuri se il tempo in cui
state su GIMP sia poco o tanto controllate anche i punti successivi. Se siete convinti di
cambiare spesso applicazione, considerate semplicemente la RAM libera e avrete fatto
la vostra decisione finale, non c'é altro da controllare.

2. Il sistema operativo swappa nello stesso disco fisico in cui GIMP swappa? Se & cosi
aggiungete la RAM libera e lo swap libero. Altrimenti continuate con il punto
successivo.

3. Il disco che tiene lo swap € piu o ugualmente veloce del disco su cui GIMP swappa? Se
e piu lento prendete solo la RAM libera, se & piu veloce o simile, aggiungete la RAM
libera e lo swap libero.

4. Ora avete un numero, che sia la sola RAM libera o la RAM libera piu lo swap libero di
sistema. Riducetelo un attimo per essere sicuri: quello € il numero per la cache
immagine che potete usare come inizio.

Come potete notare il tutto verte nel controllare le risorse libere e decidere se vale la pena
usare lo swap di sistema o se questo pud causare solo dei problemi.

Aggiustare il valore della cache e altri cambiamenti d'aiuto.

Numerosi sono i motivi che potrebbero spingere a modificare il valore. Principalmente
perché avete cambiato hardware o I'ambito di utilizzo del vostro computer. Questo
potrebbe richiedere la rivalutazione dei punti successivi che potrebbe portarvi al
medesimo o ad un valore completamente nuovo.



Altri motivi potrebbero essere perché GIMP gira troppo lento o perché le altre applicazioni
si lamentano di non avere memoria a sufficienza.

Se avete deciso di usare la sola RAM e gira lento, potete provare ad incrementare un po'
il valore senza mai ad arrivare ad usare lo swap. Nel caso contrario in cui state usando sia
la RAM che lo swap, e avete problemi di mancanza di risorse, diminuitelo.

Un altro trucco € di spostare la directory di swap di GIMP su un disco notevolmente piu
veloce o su un'altro disco rispetto al resto. Disseminare lo swap di sistema su diversi
dischi fisici & un'ottima idea per incrementare le prestazioni in generale. Magari avete solo
bisogno di comprare piu RAM o smettere di usare molti programmi contemporaneamente,
non potete pensare di editare un poster su un computer con 16MB di RAM e pensare di
essere veloci.

Genericamente potete anche controllare quanto spazio necessitino le vostre immagini. Piu
grandi sono le immagini e il numero di undo piu risorse necessitate. Questo metodo per
ricavare il numero pud andare bene solo se lavorate sempre sulla stessa tipologia di
immagini. Pud anche essere un ottimo metodo per scoprire se avete bisogno di piu RAM
0 spazio su disco.



Migliorie da GIMP 1.2.x a partire dalle librerie grafiche GTK+ 2.2.x

L'interfaccia Utente

Moltissimo lavoro € stato posto nella riorganizzazione del codice a partire dal vecchio
GIMP 1.2. Le novita piu visibili riguardano

l'interfaccia utente. Le nuove librerie grafiche | |
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Un'altra novita € il menu in alto ad ogni finestra immagine. Questa come altre decorazioni
della finestra sono opzionali e disabilitate di default o attivabili per ogni singola immagine.

Proseguendo con le novita, di grande comodita & l'editing full-screen che pud essere
attivato/disattivato premendo <F11> o tramite il menu 'visualizza'. Questo metodo ha
il suo insieme di opzioni come le outline di selezione, la barra del menu, cosi da
permettervi di eliminare tutte le distrazioni e concentrarvi su cid che & importante:
l'immagine.

Una delle caratteristiche che GIMP ha mantenuto nel corso del tempo, sono le scorciatoie
da tastiera assegnabili dinamicamente. Quando un menu € aperto si pud evidenziare con
il puntatore la voce che ci interessa, e premere la scorciatoia che vogliamo da tastiera per
modificarla. Questa feature & disattivata di default per evitare che vengano modificate le
scorciatoie accidentalmente. Oltre a questo GIMP viene distribuito con dei set di
scorciatoie per i suoi menu: se volete rimpiazzare le shortcuts di default di GIMP con
quelle usate in Photoshop, per esempio, si pud rinominare il file menurc all'interno della
directory utente di GIMP in oldmenurc e ps-menurc in menurc.

Le icone e i menu sono skinnabili, ovvero modificabili a piacere. Potete crearvi i vostri set
di icone e applicarli alla toolbox usando il menu Preferenze>Interfaccia. Un tema
alternativo gia presente all'installazione di GIMP & “small” ideale se dovete lavorare a
basse risoluzioni.



Photoshop e GIMP a confronto sul piano professionale é possibile?
(Pro & Cons)

Photoshop da i primi vagiti nel 1987 e la versione 1.0 esce nel 1990. Ora siamo alla 8.0
(entrato a far parte di quella che all'Adobe chiamano Creative Suite).

Improntare un paragone con GIMP & un'impresa ardua, ma pare sia anche la preferita da
chiunque conosca i due programmi, 0 quantomeno la prima cosa che viene da
domandarsi.

GIMP nasce nel 1995 e a confronto del suo antagonista a pagamento & un bimbo.
L'ultima versione stabile, la 1.2, in quanto programma creato, in un certo senso, da
programmatori per programmatori € da sempre risultato ostico specialmente per chi
veniva da Photoshop ma non di meno per chi cercava di creare qualcosa di semplice
senza aver mai messo mano ad un programma di grafica. Con la versione 2.0 si sono fatti
enormi passi da gigante come ho precedentemente fatto notare nelle novita introdotte
dall'interfaccia grafica ma non solo, come si vedra piu avanti.

Il reale problema nel paragonare i due prodotti, al di la dei costi di acquisto, che nel caso
di Photoshop & pari a $649, & nel decidere cosa realmente sia confrontabile. In altre
parole: quanto e per cosa conviene utilizzare GIMP come sostituto di Photoshop (se ne
state cercando uno) o come semplice programma di grafica? Gli impieghi di GIMP sono
esattamente i medesimi: dal web al fotoritocco, all'animazione e alla pittura. Sicuramente
GIMP deficita di alcune caratteristiche per un impiego tipografico per la stampa, ad
esempio la possibilita di creare immagini in quadricromia (CMYK) che e stata pianificata
per la versione 2.4, di contro Photoshop non gestisce animazioni, alcuni formati file (come
I'MNG ossia un PNG animato che molti browser stanno introducendo come standard), ed
e carente di un sistema di scripting avanzato (quindi non limitato dal puro e semplice
batch processing o macro scripting): tenendo presente questo, con GIMP tutto quello che
si puo fare, lo si puo fare bene e professionalmente, se si vuole.

L'impressione che a me personalmente da GIMP ora & quella di essere un software
sicuramente vincente sotto molti piu aspetti di quelli che sono riuscito a citare finora, come
la strutturazione dei circa 220 filtri con cui viene distribuito, che prevedono oltre ad un
impiego standard anche la possibilita di ottenere risultati inaspettati e spettacolari (come
ifsCompose —da Filtri>Render>Natura — usato nell'immagine di Angela Berezina); in
altre parole quello che € mancato a GIMP ¢ il tempo per crescere e distaccarsi da inutili
dubbi, quale potrebbe essere quello sollevato dalla mancanza di un livello di astrazione
nella renderizzazione di oggetti dinamici (sia esso del puro testo o un livello) o
dall'incompletezza del tool di testo con un sistema di formattazione serio.

Non € qui in questo contesto che proporrd delle conclusioni, scopo di quanto sto dicendo
e darvi gli strumenti necessari per crearvi la vostra personale opinione (e mi auguro che
ne siate incuriositi al punto da sperimentare, non solo teoricamente, GIMP) ed evitare che
voi vi facciate delle aspettative sbagliate, cosa che spesso capita quando si legge un
articolo “di parte” riguardo questo o quell'altro nuovo tool.

Per concludere posso inoltre ricordare che come programma legato alla comunita Open
Source, GIMP ¢ soggetto a frequentissime revisioni e aggiornamenti: basti pensare che
dalla GIMP Developers Conference avvenuta nell'estate 2003 a Berlino € sorto GIMP 2.0
nel giro di 6 mesi o poco piu.






Breve introduzione sui formati file supportati

E finalmente ora di mettere mano o quanto meno farsi un'idea di quello che si puo
effettivamente fare con GIMP.

A questo punto inizierd ad analizzare la base lavorativa di GIMP, specialmente per chi non
pretende di creare dal nulla inestimabili elaborati artistici. Cercherd di sviluppare questa
analisi partendo dai formati grafici che GIMP ha la capacita di gestire (in apertura,
modifica e salvataggio), passando alla sua interfaccia utente, che nelle versioni passate
ha destato la maggior parte dei dubbi, fino ad arrivare agli strumenti speciali con cui GIMP
viene rilasciato (sempre con un occhio al passato), e alle strutture interne ed esterne che
garantiscono un livello di elaborazione particolarmente elevato.

Il formato nativo di GIMP ¢é I'xcf, e preserva — giustamente — nel salvataggio i livelli
immagine, i canali e i tracciati, inoltre la particolarita di questo formato (e quindi di GIMP
stesso) & soprattutto nella gestione dei livelli che non sono ristretti alla dimensione
dell'immagine (come fanno la maggior parte dei programmi di grafica raster) ma sono di
dimensioni indipendenti e modificabili (si veda il menu livello da [immagine]>Livelli)
e possono essere piu piccoli (come capita per i livelli di testo) o piu grandi (utile nella
gestione delle animazioni).

Come per le versioni precedenti il tipo di file in salvataggio &€ automatico di default (ovvero
non occorre impostarlo per forza dalla lista drop-down): basta scrivere il nome file che
termini con [l'estensione del formato che vogliamo. Nello stesso modo all'apertura
qualsiasi file viene riconosciuto automaticamente.

| tipi di file che supporta GIMP sono piu di trenta ad esclusione degli pseudo-formati (a
seconda delle librerie grafiche con cui viene compilato). Giusto perché siamo ancora
freschi di un inutile confronto, GIMP pud importare i file psd di Photoshop (purtroppo non
riconoscendo gli stili di livello in quanto GIMP ne & sprovvisto, come facevo notare
poc'anzi) e la quantita di opzioni per ogni singolo formato file & particolarmente
professionale come la possibilita di poter inserire dei commenti immagine, o leggere e
modificare i contenuti dei campi EXIF.

Come dicevamo all'inizio non Vv'é la possibilita di gestire nativamente la quadricromia (per
ora) ma per le immagini RGB e — specialmente — per quelle indicizzate vi &€ un controllo
diretto sulla gestione dei colori.

Come nota aggiuntiva vi & la possibilita di importare formati SVG, non solo come
immagine raster, come si pud fare con gli altri standard vettoriali tipo PS ed EPS, ma
anche importandoli o esportandoli come tracciati. Impossibile non citare la capacita di
importare ed esportare in formato ASCII.

Tutto cid non fa altro che riconfermare GIMP come un prodotto flessibile ed adattabile a
qualsiasi impiego.



Introduzione su interfaccia di lavoro di GIMP 2.0. Dialogs e gestione
dell'immagine (Usi Basilari di GIMP ed esempi).

Lo strumento di testo

Come gia annunciato il text tool & stato finalmente riscritto completamente e ora per
creare una scritta c'€ molto meno di cui impazzirci.

Tenendo presente che GIMP 2.0 si porta dietro, speriamo ancora per poco, alcune
deficienze dell'ormai vecchia versione 1.2 (tipo la necessita di controllare di aver
selezionato il livello — immagine, canale o tracciato che sia — che si vuole editare), lo
strumento di testo da la possibilita di impostare una formattazione minima piu qualche
altra opzione; inoltre il livello creato, delle dimensioni poco maggiori del testo, & un livello
speciale ed e possibile modificarlo successivamente cliccando sopra la scritta con lo
stesso strumento due volte. Qualsiasi tipo di modifica grafica ritrasforma il livello in uno
normalissimo che perd mantiene sempre un campo di informazioni sul testo rendendolo
comunque editabile in futuro (si veda anche: Tasto Destro>Livello>Abbandona
Informazioni Sul Testo).
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Per creare del testo basta cliccare sullimmagine e si aprira I'Editor di Testi di GIMP
come si pud vedere nell'immagine qui sopra. Non appena avremo inserito il testo verra
creato automaticamente il livello sul quale possiamo applicare una serie di opzioni di
visualizzazione a seconda delle necessita.
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La finestra delle opzioni relativa a questo strumento offre delle interessanti opzioni, al di
la della formattazione base (scelta carattere, dimensione e relativa unita di misura, colore,
allineamento, identatura paragrafo e spaziatura tra le righe), come l'uso dei suggerimenti
o degli autosuggerimenti e la possibilita di abilitare o disabilitare I'antialiasing ed infine di
creare automaticamente il tracciato dal testo.

dei metodi per alterare la rappresentazione del bitmap | @' C=! et Ginp! Gimpl
per una lettura piu chiara a piccole ampiezze. Per darne
chiaro esempio, nell'immagine qui a lato nella parte alta
si pud notare la scritta “Gimp!” a 10 pixel di corpo

ripetuta per 6 volte. Da sinistra a destra: le prime tre
scritte sono senza antialiasing: la prima senza nessun , . H
tipo di suggerimenti, la seconda solo con suggerimenti H_ p .

ma non autosuggerimenti, la terza con suggerimenti e
autosuggerimenti; le ultime tre scritte sono con
antialiasing, la prima senza nessun tipo di suggerimenti,
la seconda con solo suggerimenti, la terza ed ultima con
entrambi.




Per finire sempre nella stessa immagine, in grande appare la stessa scritta di cui sopra a
corpo 64 pixel: la prima (dall'alto) con antialiasing (senza autosuggerimenti), subito sotto il
tracciato visibile, ricavato da “Crea Tracciato dal Testo” dalla finestra opzioni ed infine la
ricalcatura del medesimo tracciato per 2 pixel di spessore.

Lo strumento per i tracciati (path)

Lo strumento per i tracciati, creabili tra l'altro da una selezione gia attiva tramite
Seleziona>Nel Tracciato 0, come visto poco fa, anche tramite la finestra opzioni
dello strumento di testo, &€ stato programmato ex novo: da notare che il metodo di
creazione dei path & del tutto analogo (almeno dal punto di vista strutturale) a Sodipodi
(programma di disegno vettoriale Open Source) e comunque non lontano (basilarmente)
da un qualsiasi altro programma di grafica vettoriale conosciuto sotto Windows®©.

Per chi non conoscesse 'uso o le potenzialita dei tracciati € necessario fare una piccola
nota esplicativa: il tracciato € un'insieme di punti (detti nodi) consecutivi che tracciano
graficamente una curva; la direzione della curva stessa & data dalla “tensione” e direzione
dalle ancore sui ogni singolo nodo; il tracciato viene gestito in maniera totalmente
separata, su un livello diverso sia strutturalmente che fisicamente. |l tracciato infatti
definito vettoriale: ha quindi una rappresentazione puramente matematica, a differenza
del bitmap, dove limmagine & data dalla posizione dei singoli pixel (finiti e numerati)
ciascuno con i propri valori colore, RGB+Alpha: il vantaggio risiede effettivamente sulla
sua scalabilita e precisione a piccole e grandi dimensioni, oltre a consentire una elevata
modificabilita tramite i nodi e le loro ancore.

La creazione di un tracciato in GIMP ¢ realizzabile in vari modi: uno di questi & stato visto
poco sopra, tramite la finestra opzioni dello strumento di testo; € poi possibile ottenerne
uno da una selezione qualsiasi attiva nell'immagine (da Tasto
Destro>Seleziona>Nel Tracciato); da un tracciato preesistente, cliccando due
volte sul tracciato nella scheda relativa (verra automaticamente selezionato lo strumento
per i tracciati e reso attivo il tracciato stesso) o piu semplicemente selezionando
manualmente lo strumento per i tracciati e iniziando a porre il primo nodo.

Superato il dubbio che per chiudere i tracciati che abbiamo creato occorre premere
<CTRL>, € possibile ottenere la selezione, ricalcare, esportare (ed importare) in formato
SVG il tracciato.

La combinazione dei tasti <CTRL>, <ALT> e <Maiusc> da la possibilita di ottenere
qualsiasi tipo di interazione con i tracciati attivi; in piu, anche se in queste prime release si
presenta in uno stadio piuttosto primitivo, si pud, con una semplice operazione di “drag &
drop” interagire sulla curva sottesa a due nodi per modificarne la forma, un po' quello che
si puo fare su Flash di Macromedia®©.

Per terminare riguardo le possibili modifiche effettuabili, i cinque nuovi strumenti di
trasformazione introdotti (Ruota, Scala, Distorci, Prospettiva e Rifletti) presenti nella
finestra degli strumenti insieme allo strumento di spostamento, non sono solo applicabili ai
livelli bitmap, ma anche (si veda le relative finestre opzioni o premendo selettivamente
<CTRL> 0 <Alt>) alle selezioni e ai tracciati.

Una volta ottenuto il nostro tracciato finale, che per inciso non apparira in esportazione se
non in formato SVG e che comunque verra salvato solo nel formato nativo XCF, possiamo
convertirlo in bitmap su un livello creato e selezionato precedentemente.

L'uso piu frequente € nella creazione di riempimenti, ottenendo una selezione dal
tracciato (si faccia attenzione che il tracciato, se non & chiuso, verra chiuso nella selezione
dalla parte concava) tramite il tasto posto in basso nella finestra dei tracciati oppure dalla
finestra dei tracciati Tasto Destro sul tracciato desiderato>Tracciato A
Selezione (0 qualsiasi altra operazione con una selezione gia presente).



TODO:

- Creazione e chiusura tracciato, uso delle curve Bezier e con mouse e ancore.
- Ricalco tracciato per outlines.

- Creazione selezione per riempimenti.



Strutture Avanzate per la gestione dell'immagine in GIMP

Batch processing, macro scripting e script-fu.
Nota generale sui filtri: 220 nativi + infiniti gratuiti.

GIMP continua la sua tradizione di permettere add-on in diversi linguaggi di
programmazione.

Usando il PDB (Procedural Database, [Toolbox]>Xtns>Browser DB)
<CFR>

per registrare una plug-in la rende immediatamente disponibile a programmatori in C,
Script-Fu (un binding di Scheme interno basato su SIOD), Python e Perl. | linguaggi di
scripting possono essere usati per ripetere velocemente una sequenza comune di
modifiche all'immagine e operazioni con i plug-in stessi, o per scrivere un nuovo plug-in da
zero.

Gimp-Perl non & piu distribuito con la distribuzione classica di GIMP 2 ma & disponibile in
un pacchetto apparte. Include sia il un semplice linguaggio di scripting sia la possibilita di
scrivere un codice piu pulito con interfaccie usando il modulo GTK+ 2 Perl.

Gli scripts Script-Fu sono interpretati direttamente da GIMP e non richiedono alcuna altra
installazione software. Python-Fu richiede che si installi Python 2.2 e Perl-Fu richiede Perl
5.8.

Uno script &€ un file di testo con una serie di comandi che vengono eseguiti
consecutivamente (esattamente come uno shell script o -basilarmente- come un file di
batch).

Lo script viene quindi impiegato come plug-in. Registrando questo plug-in all'interno del
PDB lo si rende disponibile per l'uso interno ed esterno del programma.

(Script-fu € un linguaggio di scripting Scheme basato su SIOD)

Gli script inoltre rendono disponibili delle strutture di controllo per modificare la sequenza
di esecuzione dei comandi in base ad una variabile di controllo, (in altre parole
contengono tutti gli aspetti della programmazione imperativa) quindi sono dei veri e propri
linguaggi di programmagzione di alto livello garantendo massima flessibilita.

Script-Fu € interpretato direttamente da GIMP; Python-Fu richiede l'installazione di Python
2.2 e Perl-Fu richiede Perl 5.8.

Uno script di esempio:

Ottimizza il contrasto su una foto (in particolare il livello su cui si sta operando se ha piu di
un livello). Offre un apprendimento basilare del sistema di organizzazione degli script di
GIMP.

Per maggiori informazioni su script-fu consultate queste utilissime guide online:
TODO:

- lista di link

- Black Belt Shool of Scripting

- gug.sunsite.dk

- siod interpreter manual

- forum vari di supporto



(define (script-fu-optimize-contrast thelImage thelayer)
; creo due copie del livello di partenza
(set! base-layer (car (gimp-layer-new-from-drawable thelayer thelImage)))
(gimp-image-add-layer theImage base-layer 0)
(set! new-layer (car (gimp-layer-new-from-drawable thelayer thelImage)))

(gimp-image-add-layer theImage new-layer O0)

; applico le trasformazioni
(gimp-desaturate new-layer)
(gimp-invert new-layer)
(plug-in-blur 1 theImage new-layer)

(gimp-layer-set-mode new-layer 5)

; nascondo il livello base di partenza
(gimp-layer-set-visible theLayer 0)
; incollo le immagini di partenza

(gimp-image-merge-visible-layers theImage 0)

; aggiorno l'immagine - fine dello script

(gimp-displays—-flush)

(script-fu-register "script-fu-optimize-contrast"
_"<Image>/Script-Fu/Decor/ Optimize Contrast..."
"Optimize contrast on drawable:

good result on high contrasted photos.
Works only on RGB+Alpha and Gray scaled+Alpha images."
"The Peach <peach@smartart.it>"
"The Peach"
"14/07/04"
"RGB* GRAY*"
SF-IMAGE "image" O
SF-DRAWABLE "drawable" 0



Gif e animazioni: un sostituto per Fireworks o Animation Shop?
TODO:

- The GIMP Animation Package (installazione)

- Esempi

Strutturazione di un xcf per I'animazione, organizzazione livelli etc...

Formati di salvataggio (gif, mng, mpeg1, mpeg2)

Editing video avanzato con il GAP



